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A “How to” guide for Business Objects Application
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This desk guide was developed as a reference for the “How to” do operations related to the Business Objects reporting tool.  Technical information was derived from Business Objects – America.  Specific information can also be found using the “Help” menu within the application.  

Suggestions for improvements of this document should be directed to: 

Civilian Personnel Operations Center Management Agency

5440 Student Drive

ATTN SFCP-MAT

Aberdeen Proving Ground, MD  21005-5200

Comments may also be e-mailed to:  CPOCMATMD@cpocma.army.mil
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Chapter 1 - Introduction
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The Modern Defense Civilian Personnel Data System (MDCPDS) is a large relational database.  As Personnelists, we know information (data) is put in to MDCPDS via Requests for Personnel Actions (RPA), formerly those blue forms called SF-52s, or by direct data updates from regional Civilian Personnel Operation Centers (CPOCs).  One important byproduct that comes out of our Personnel System is the Notification of Personnel Actions (NPA) formerly called a SF-50).  There is so much data in MDCPDS a practical system must be used to get information out.  Something is needed to get information and reports on a wide range of topics for a variety of audiences.  The Business Objects Application (BOA) reporting tool was selected to replace DESIRES, the reporting tool used in the "Legacy" system.  DESIRES is a powerful tool, but it was not "user friendly."  Especially for those who did not use it on a regular basis. 

BOA is a Windows, Structured Query Language (SQL) based program that interprets and "writes" the SQL for you.  You don't have to know SQL.  If you know SQL you will appreciate all the shortcuts.  If you don’t know SQL, the hard work is done for you.  BOA provides the power to pull information out of the CSU, Resumix, and Productivity databases.  The CSU database is where information came from that populated “Regional Applications.”  BOA is a “read only” application so there is no way, with this application, to make changes or affect MDCPDS.  Once you start using BOA you will see how intuitive the application is and how forgiving it is should you not get something right the first time you try.  "Undo" buttons sure help.  As you will see, BOA is powerful and user friendly.  It is a little different, so it will take some training and practice to get you going.  So, let's get started.

Getting Started

There are three types of BOA users.
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Which ever user type you are, you will need to know how to logon to BOA.

Logging on to BOA

 XE "Logging on to BOA"  - Depending on how you are set up, you can log on using Client Server or Citrix.

How to Logon to BOA using Client Server

 XE "Logon using Client Server" .  If you have the Business Objects Application loaded on your PC:
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1.  Hit Start; 
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2.  Select the Programs icon; 
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3.  Locate and select the Business Objects Group; 
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4.  Select the Business Objects icon                                           

[image: image10.png]


You will get the following Logon screen.

5.  Carefully type in your User Name" and Password.  Use "Tab" key or point the cursor with your mouse to switch between them.

Note:  The logon for BOA is case sensitive.  You only get 3 tries.  If you fail to log in correctly, you will have to contact your BOA Supervisor to be reset.

6.  Click OK.

How to Logon to BOA using Citrix

 XE "Logon using Citrix" 
1.  Locate your Citrix / Metaframe Neighborhood icon for BOA.

2.  Enter your Citrix / Metaframe user name.  Once you get the “logon” screen, continue with steps 5 and 6 from above.

The Main Window

As you see, this is a typical Windows screen.  There are several ways to navigate.  There are menu options; toolbar buttons; shortcut keys; and speed-menus.

[image: image11.bmp]
The Standard and Report Toolbars are what you will be using.  Other toolbars will also be used.  Depending on how your PC is setup, it may be different.  There are a variety of ways to show or hide tools.  You will individualize your screen to help you accomplish the things you do most often.  

To set up your own toolbar: XE "Set up your own toolbar:" 
1.  Position the mouse pointer in the toolbar area (even the gray area will);

2.  Click the right mouse button.  A Speed-menu appears, listing the available toolbars.

3.  Choose the toolbars you want from the list.
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Help 

- BOA provides context-sensitive help from any window..  There is a general help, this guide and the "Quick Tour of Business Objects."

To get context-sensitive help at any time XE "Context-sensitive help at any time"  - Click on a Help button in the BOA window if there is one, OR press the F1 key. 

To get general help XE "General help" :

1.  In the BOA main window, click Help, Business Objects Help, or press F1.

2.  Close the Help window by clicking Cancel. 

Opening Documents / Reports

 XE "Opening Documents / Reports"  - BOA documents can be store in your local folders or in a shared folder on your network.

Document XE "Document"  is a collection of reports organized by tabs.  Like a book, documents contain chapters.  Like a chapter in a book each report can contain several pages.  Blocks and cell elements are placed on the pages of a report to visualize data. 

Report XE "Report"  is a collection of page elements within a tab section of a document.  A report consists of several pages in which a block or blocks expand.  A singe BOA document may contain several reports in the same way an Excel document may contain several worksheets.  Each report within a BOA document is assigned a specific tab.  

To open a document XE "Open a document"  in a local or shared folder:
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[image: image14.bmp]1.  Click on the         (Open) button in the Standard Toolbar.  The Open window is displayed, showing BOA document that are available.

Note:  BOA reports have a .rep extension.  The default location for BOA reports is the UserDocs folder.

2.  Choose Report-One and click Open.  The report will open.

Notice that the Data Manager is displayed in the left side of the window.  This is a default that you can change if you wish.
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To change the view in the Data Manager, click on the         (Data manager) button in the Standard Toolbar.  It is a toggle. Click it a few times and you will see it change views each time. 

Viewing Documents

[image: image16.bmp] XE "Viewing Documents"  - BOA documents are similar to Microsoft Excel workbooks.  A number of Reports can be held in a single BOA document, just as several worksheets fan be held in a n Excel workbook.

Each report is identified as a separate Tab.  

To go between reports in a document XE "Go between reports in a document" , just click on the different report tabs.

1.  Click on each of the tabs in turn to see the basic blocks used by BOA to display the data.  

  A Block XE "Block"  is a single table or chart. 

  Table Block XE "Table Block"  is a report containing a table.

  Financial Block XE "Financial Block"  is a report containing a finical table, where the table headings are shown down the left side of the table.

  Cross-tab Block XE "Cross-tab Block"  is a report that shows data presented as a cross-tab table.

  Chart Block XE "Chart Block"  is a report that show data presented as a chart.

2.  Right click on the Chart Block tab.  A Speed-menu is displayed showing the relevant options available:
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3.  Choose Rename Report XE "Rename Report"  from the Speed-menu.  The Rename Chart Block box will display.

4.  Type 3-D Column Chart in the box and click OK.

Notice that the name of the report on the table has changed to 3-D Column Chart.

[image: image18.bmp]Refreshing a Document

 XE "Refreshing a Document"  - To update the data in a report you are working on you would "Refresh" the report.

Note: You can only refresh a report if you are working in Online Mode.
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You can tell when the report was last refreshed by looking in the status bar at the bottom of the BOA window and see 
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To refresh a report XE "Refresh a report" : - Click the              (Refresh Data) button in the Standard Toolbar.  The data is refreshed.                               This may take a while depending on the size of the database and the number of current users.  When complete, a new date will be displayed in the Status Bar.

Saving a document

 XE "Saving a document"  - Documents are saved using normal Windows methods.

To save your document or report: 

[image: image21.png]Coft Holght & Widh
i ]

—





1.  Click File, Save or click the          button in the standard Toolbar.

Saving a report using a different name

 XE "Saving a report using a different name"  

To save your report under a different name:

1.  Click File, Save As.  The Save As window opens.

2.  Type a new document (report) name in the File name box.  

3.  Click Save.

Closing a Report XE "Closing a Report" 
- To close a report Click File, Close.

Logging out
 XE "Logging out" 
 of BOA - To exit from BOA, click File, Exit.

Chapter 2 - Working with Data

This chapter shows how to make your documents more accessible and to change the report layouts.  You will see how to resize columns and rows in tables; change the order columns are displayed; add simple calculations; and apply sorts and filters.

Formatting

Resizing Columns and Rows

 XE "Resizing Columns and Rows" 
Open an existing document.  Typically they contain a table.  Notice how the columns are formatted.  You can resize the columns and rows manually.

To resize columns:

[image: image22.bmp]
1.  Place the cursor / mouse pointer between two columns.  The pointer changes to       when you are over a vertical column line.

2.  Press and hold down the left mouse button.

3.  While holding down the left mouse button, drag the line left or right, to the desired position.

4.  Release the left mouse button.

To resize row heights manually XE "Resize row heights manually" 
[image: image23.png]Calculations




1.  Place the cursor / mouse pointer on a line between two rows in the data section.  The pointer will change to       when you have a horizontal line between two data rows.

2.  Press and hold down the left mouse button.

3.  While holding down the left mouse button, raise or lower the mouse pointer to the desired height.

4.  Release the left mouse button.

Note:  Only the rows of data are changed.  The title cell does not change.

To resize the title cell height manually XE "Resize the title cell height manually" :

1.  Place the mouse pointer on the bottom line of the title cell heading row.

2.  Press and hold down the left mouse button.

3.  While holding down the left mouse button, move the mouse up or down to the desired height.

4.  Release the left mouse button.

Note: In all of the above moves, if you are not satisfied with the placement, hit the undo button and try again.

Automatic Resizing XE "Automatic Resizing"  - BOA will automatically format your tables.

To resize a column automatically:

1.  Position the mouse pointer between the two columns you want to change.
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2.  When the pointer changes to     , double click the left mouse button and the column will resize automatically.

To resize rows automatically:

1.  Position the mouse pointer on any row border.

[image: image25.bmp]
2.  When the mouse pointer changes to       , double click the left mouse button and the rows will resize automatically.

Auto-Fit Feature XE "Auto-Fit Feature" - Using this feature, you can specify the size of the columns and rows.  

To use the Auto-Fit feature:

1.  Select the parts of the table you want to resize.  You have "selected" the parts when they change colors.  

Note:  For columns, you must select the whole column, including the column heading.

2.  Click Format, Cell Height and Width -  The following cell will appear 

[image: image26.bmp]
3.  Enter the values in the appropriate boxes for Width and Height. 

4.  Click OK.

Note:  If you are not satisfied with the results, hit the undo button and try again.

Moving Columns

 XE "Moving Columns" 
To change the order of the columns in a table

1.  Select the column you want to move by clicking the data area with the left mouse button.  The selected column will change colors.

[image: image27.bmp]2.  Drag the column to the new location.  The mouse pointer will change to two opposing arrows              when you are doing this correctly. 

3.  Release (or drop) the left mouse pointer.

Changing Column Titles

 XE "Changing Column Titles" - BOA places the field names of the data source as the default column title.  

To change the default title:

1.  Double click on the heading you wish to change.  When the heading is highlighted you will be in text mode.

2.  Type in the title of your choice.

3.  Press Enter.
Note:  Even though the title has changed, the data source remains the same.

Moving Tables

 XE "Moving Tables"  - Tables can be positioned anywhere o a report by dragging and dropping them to the desired location.

To Move Tables:

1.  Click anywhere inside the table to display the table boarder.

[image: image28.bmp]
2.  Move the mouse pointer over the border until it changes into a cross. 

3.  Click and hold down the left mouse button and drag the table to the desired position.

4.  Release the left mouse button.

Moving a Report Title

 XE "Moving a Report Title"  - There may be times when you wish to move / adjust the report's tile cell.

To Move a Report Title:

1.  Click on the title cell.  When selected, the title cell will change colors.

2.  Click and hold down the left mouse button.

3.  Drag the cell to the desired position.

4.  Release the left mouse button.

Calculations

Applying Calculations to Columns
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 XE "Applying Calculations to Columns"  - Make your table more informative by adding some simple calculations.

To Apply Calculations to Columns:

1.  Move the mouse pointer over a table column.

2.  Click the right mouse button.  A Speed-menu will display

3.  Move the mouse pointer over Calculations in the Speed-menu.  A choice of calculation functions will appear.

Note:  To close this menu, click anywhere outside the Speed-menu.

Adding a Sum

 XE "Adding a Sum"   (You may wish to save your report under a different name to make a back up.  You can also click the report tab and select Duplicate Report.)

To add a sum:

1.  Left click with your mouse on a column.  The column will change colors.
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2.  Click the       (Insert Sum) button in the Report Toolbar.  You can also right mouse click and select Sum from the calculation's Speed-menu discussed above.  An overall total for the selected column will be added to the bottom of the column.  If your table has a large number of rows, you may have to scroll to the bottom to see the total. 

Note:  Sum and other functions such as Average and Maximum are examples of aggregation.

Adding a Percentage

 XE "Adding a Percentage"  - On columns containing measurable items, you can have BOA add a Percentage column to your table.

To Add a Percentage:  

[image: image31.bmp]
Select a column with measurable items and click the         (Show as Percentage) button in the Report Toolbar.  A new column called Percentage is added to the table and automatically resizes the affected columns.

Applying a Count

 XE "Applying a Count"  - BOA features include Count and Count All.

• Count function, counts distinct values only.

• Count All function, counts all the rows in a column, including duplicates and empty rows.

To apply the Count function:

[image: image32.bmp]
• Left click the mouse pointer on the data in any column and click on the           (Insert Count) button in the report Toolbar.  A row is added to the bottom of the table showing the number of distinct items.

To apply the Count All function XE "Count All function" :

1.  Right click the mouse pointer on the data in any column and 

2.  Click on Calculations, Count All.  A row is added to the bottom of the table showing the number of rows in the column.  Not just the number of distinct rows.

Removing Calculations

 XE "Removing Calculations" 
To remove calculations from a table:

1.  Right click on the data in the column in question.

2.  Click Calculations, Count All.  The Count All total is removed from the table.

3.  Left click on any of the above calculation currently in the table.  By clicking on the icon or selection that placed the calculation in the table, it will remove it.

Note:  If you mistakenly select the wrong item, hit the undo button and try again.

Sorting Data

[image: image33.bmp] XE "Sorting Data"  - BOA sorts data initially from left to right.  You can sort the table in different ways by using the            (Insert Sort) button in the Report Toolbar.

Applying and Removing Sorts XE "Applying and Removing Sorts"  - The default sort is ascending on the first column.  

You can change the sort by:
1.  Left click on the column you would like to sort.  Since the default is ascending, you may want to change the sort to descending.
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2.  Left click on the arrow in         (Insert Sort) button in the Report Toolbar.  The sort options are displayed.

3.  Click on the down arrow button.  This will change the sort to descending.

4.  Click on the button again to remove the sort.  This is know as a toggle.

Try this again using another column with an ascending order.

Managing Sorts

 XE "Managing Sorts"  - You can keep tract of the sorts on a block by using the Sorts option.

To do this:

1.  Click Format, Sorts on the table you were just practicing.  The Sorts window will display. 
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2.  You can change the order of the sorts by selecting the column in the Current Sorts box and clicking the Move Down or Move Up buttons.

3.  Click OK when you are ready to make the change.

Custom Sorting

 XE "Custom Sorting" 
If you need to sort in an order that is not numerical or alphabetical you can use the following procedure.
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1.  Selecting the down arrow in the Insert Sort icon you will also see a hand with an arrow next to it.

2.  Click on the hand.  The Custom Sort window will display.  The sort options box provides a drop down list of predefined sort orders.  Examples of non-numeric or alphabetical sorts are sorts by Day or Month.

Filtering

Filtering Data

 XE "Filtering Data"  - Depending on the size of the data selected, there may be ways of not selecting items or "filtering" items out of your report.  A filter allows you to view only the data you want.

To apply a filter:

1.  Click on a column that has more information than you need.
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2.  Click on the            (Insert Filter) button in the Report Toolbar.  The Apply a Filter On (column name) window opens.  In the Values box, all of the variables for the selected column will appear.

3.  Click on the item you want.

4.  Click OK.  The table will now only include the item you selected.  If you had any calculations included with your table, they will be adjusted.

Removing a Filter

 XE "Removing a Filter" 
To remove a filter:

1.  Click on the column that contains the filter you want to remove.  You will see that the (insert Filter) icon is "pushed in." 


2.  Click the           (Insert Filter) button again (toggle).  The filter is removed and all the data in the table will display again.

Note:  Remember to save your reports or to rename them.  Use the Save As feature in the File menu.

Chapter 3 - Drilling XE "Drilling" 
Drill Mode

 XE "Drill Mode"  - Drill mode allows you to analyze data from different angles and on different levels of detail.  Typically, you start off by looking at the high level data and when you spot an unusually low or high value, or an unexpected value, you can analyze it by displaying related data on a more detailed level.  This allows you to see how different factors affect your organization.

When you make a query on a BOA universe, the objects you can include are grouped in folders and organized in a specific order.  The creators of the "Universe" organized it in a hierarchy, with the most general object in the class at the top and the most detailed at the bottom.

Universe XE "Universe"  is an organized collection of information.  The Universes is a subject specific-semantic layer.  Each universe contains just the objects its intended audience needs, excluding the objects that are of no interest.  In Army we will be using separate universes for Productivity, Resumix, Regional Reports.  A universes will be set up for Headquarters ACPERS data to replace the current HQ ACPERS database.  Again, each one set up for a specific audience.

Object XE "Object"   is a logical piece of information.  It may be anything used to build queries and to retrieve data for reporting.   Objects are grouped to make it easy to find things.  They are classified inside the groups so that if you want to make a high level report you know you need to include objects at the top of the list in your query and if you want a more detailed report than you choose objects from further down the list.  

There are four types of Objects in BOA:  Dimensions, Details, Measures and Conditions.

• Dimension XE "Dimension" .  A dimension is a logical piece of information that is the focus of analysis of the end user.  Dimensions are the objects you base your query on.  Dimensional objects are represented on screen by a blue cube.  

• Detail XE "Detail"   A detail is an additional piece of information about a dimension object. It is information we want listed  in the report, but is not the focus of the analysis.  A detail is represented on screen by a pyramidal symbol.

• Measure XE "Measure" .  Measures represent aggregates.  A measure is semantically dynamic.  Its value is based on the objects included with it in the query.  Measure objects are symbolized by a pink sphere.

• Condition XE "Condition" .  A condition is a predefined restriction of information.  It sets a limit on the scope of the query.  It is represented on screen by a yellow filter shape.

Hierarchies

 XE "Hierarchies" 
A hierarchy is like a map.  This map tells BOA the next detail level to display when a user drill.  Hierarchies are built by the Universe Designer.  Users can drill up, down and sideways.  Objects are also organized in this way for drilling.  When you analyze data in drill mode, you use hierarchies.  The Universe classes are the default hierarchies you use for drilling but the Universe designer can also set up custom hierarchies.  You can create and edit hierarchies in your reports.

Drill hierarchies only contain dimension objects.  In drill mode, you drill down on dimensions.

When you set up a report for drilling, you include high level objects to display in your table or chart but include more detailed objects in your scope of analysis.  BOA retrieves these objects from the selected database and stores them behind the scenes in your report so they are there when you need them.  Before you can analyze data in drill mode, you have to set up this behind-the-scenes the data.

NOTE:  To use Drill mode your document must contain a hierarchy.

              Before you can analyze data in drill mode, your report must contain data which has been set up for analysis.

Switching to drill mode

 XE "Switching to drill mode"  - Open drill mode from a BOA report.  

To do this:

1.  Select the table, cross-tab or chart that you want to analyze in drill mode.  You can only analyze one block at a time.


2.  Click the        Drill button on the Standard toolbar or choose Drill from the Analysis menu.

If no part of any table, chart or cross-tab was selected before you clicked the drill button, the cursor becomes a magnifying glass with a question mark next to it.  If this happens click inside the table, chart or cross-tab you want to analyze.  

When you go into drill mode, by default:  

• A new report is created which contains a copy of the selected table; cross-tab or chart.  The report tab displays the drill icon to show you are in drill mode.  The original report remains intact.

• A sum is added on measure objects.

• If you are working on a master/detail report the Drill toolbar is displayed.  Note: You can change these default options.  

You are now ready to drill on the data in the report.


Drill This cursor appears if you do not select a block before switching to drill mode.  

Drilling down

 XE "Drilling down"  - When you drill down, you display the next level of detail in a hierarchy.

To drill down:

1.  Rest the cursor over the data.  The cursor changes to a magnifying glass with a plus sign in it.          The plus sign indicates that you can drill down on this value.  A tool-tip shows you the next dimension in the hierarchy:

2.  Double-click the value.  The data for the next dimension appears in the table and the selected value is appears in the Drill toolbar.  

Continuing to drill down - Each time you drill down the value drilled on is moved to the Drill toolbar and the data in the table is filtered according to the values displayed in the Drill toolbar.

A “tool-tip” will show up in yellow over the affected cells showing the next dimension in the hierarchy.  You can drill down as long as there are objects in the hierarchy.  When you reach the last level in a hierarchy, the normal cursor is displayed.  This indicates you are at the bottom of a hierarchy.  

Note:  If tool-tips are turned on, a tool-tip displays the message “Right-click to explore.”

Displaying different values in the Drill toolbar - The block is filtered to only show data for the values currently displayed in the Drill toolbar.  

To change the values in the toolbar to look at data for a different value:

1.  Click the down arrow.

2.  Choose a value from the drop-down list.  The data for the chosen value is displayed in the table.

Tip: You can also click in the box and type in the first letter of the next value you want to display (making sure you type a capital letter if necessary).  When you press Enter, the value is displayed and the table or chart is updated.

Drilling up

 XE "Drilling up"  - Drilling up is the opposite of drilling down.  When you drill up, you go back up through the hierarchy to display data on less detailed levels.

To drill up from one dimension to the next:

1.  Place the cursor over a value.

2.  Right-click on the value you want to drill up on and choose Drill Up from the pop-up menu.  The data for the next level up is displayed.  If you have drilled down to the bottom of a hierarchy the magnifying glass cursor is no longer displayed.

Undoing drill actions

 XE "Undoing drill actions"  - You can undo up to ten drill actions which can be useful if you lose track of your analysis.  


To Undo drill actions: - Choose Undo         from the Edit menu.

Drilling By

 XE "Drilling By"  - When you drill down and up you move through the levels of the same hierarchy.  If you cannot find the answer to a question by analyzing data in its current hierarchy, you can move to another hierarchy to analyze other data that belongs to a different hierarchy.

Before you can drill across, your report must contain dimensions from more than one hierarchy.  If this is not the case, you can:

• Retrieve data for dimensions from more than one hierarchy by expanding your scope of analysis, or

• Create new hierarchies inside the report.  

To drill down to another hierarchy:

1.  Right-click a value and choose Drill By from the menu.  The list of dimensions that you can drill to appears on a sub-menu;

2.  Choose a dimension from the list.

Drill By – More

 XE "Drill By – More"  - The list in the Drill By sub-menu displays five dimensions only by default.  

To display the full list of dimensions:

1.  Right-click a value and choose Drill By then More from the menu.  The Drill By - All Available dialog box opens.

2.  Choose a dimension from the list and click OK.  The dimensions displayed in gray are already used in the current analysis.  Note: You can change the setting in the Drill By menu to display more items. 

Drilling on Charts

 XE "Drilling on Charts"  - Drill on chart blocks the same way you drill on tables and cross-tabs.

To Drill on Charts:

1.  Place the cursor over a part of the chart.  A tool-tip appears to indicate the next dimension down in the hierarchy and the cursor turns to a magnifying glass.

2.  Double-click.  The chart is updated and the value you drilled on is displayed in the Drill toolbar.  

Drilling on Multiple Hierarchies XE "Drilling up on multiple hierarchies" 
 XE "Drilling on Multiple Hierarchies"  - If your block contains more than one hierarchy, you can simultaneously drill down from one dimension to the next in all the hierarchies in the block.  You must drill down on a measure object.

To Drill on multiple hierarchies:

1.  Rest cursor over the selected column.  A tool-tip shows you what you can drill down on.

2.  Double-click on the column in the cell that displays the information your are seeking.  This is the highest value in the column.

To drill up on all dimensions:

• Right-click on a measure object value and choose Drill Up from the pop-up menu.  The tool-tip shows you can drill down on two hierarchies.  

Drill Techniques XE "Drill Techniques" 
Setting up hierarchies for drill mode - Drill mode enables you to analyze data on different levels of detail.  You perform analysis by navigating up, down and across hierarchies of data in a report.  You drill down on the data to examine the details of more consolidated data.  You drill up on data to examine totals for the underlying data.  Your ability to drill on data requires that the data be organized into hierarchies.

Note: You can only work in drill mode if you have installed the EXPLORER option with BOA.

When you use queries on universes to retrieve data for your reports, you can build hierarchies with the Scope of Analysis feature.

• You can edit the hierarchies and build new ones inside the report.  You can even change the qualification of the data returned, for example to change a detail object into a dimension so that you can include it in your hierarchy.

• BOA can automatically create hierarchies if the dimensions returned have a logical structure.

• The name given to a hierarchy is also the name of the first dimension it contains.

Using the Drill toolbar XE "Using the Drill toolbar"  - Use the Drill toolbar to filter the data displayed in the block you are analyzing.  If you hold your cursor over one of the boxes a tool-tip appears showing you:

• Which hierarchy the chosen value belongs to.

• The name of the dimension.

• A list of the top three values available for that dimension.  Replace a variable the icon of one of the variables the variable over the variable you want to replace the Drill toolbar shows the Replace highlighting the status bar displays Drop to replace contents

To insert a variable, click the icon of the variable you want to insert drag the variable to where you want to insert it and “drop it” to insert it. 

Note:  Three dots after the list of values indicates that more values are available than those shown in the tool-tip list.  You can display a value from the list by typing in the first letter on the keyboard.

Removing an object from the Drill toolbar

 XE "Removing an object from the Drill toolbar" 
1.  Click the arrow next to the object name.

2.  Choose (Remove) from the list.  The cell disappears from the drill toolbar, and the data for the variable is no longer displayed.

Moving an object from the Drill toolbar to the block

 XE "Moving an object from the Drill toolbar to the block" 
1.  Click the arrow next to the object name.

2.  Choose Move to block from the list.  The cell disappears from the Drill toolbar and a column of data is added to the table.  

Re-organizing the Drill Toolbar XE "Re-organizing the Drill Toolbar"  - You can re-organize the order in which variables are displayed in the Drill toolbar.

To move a variable click the icon of the variable you want to move and drag the variable to where you want to insert it.

Tip: You can drag the drill toolbar from its docked position under the other toolbars and place it where it is convenient for you in your workspace.

To swap two variables XE "Swap two variables"  click the icon of one and drag it over the variable you want to swap it with.  The mouse cursor becomes a swap icon the status bar displays.  “Drop” the icon to swap.

Drill Through XE "Drill Through" 
To Drill Through:
1.  Right-click on the column or row where you want the new data to be displayed.

2.  Choose Drill Through from the menu.  The Drill Through dialog box is displayed.

3.  Choose a dimension and click OK.  The dimension is retrieved from CSU Database and displayed in the block you are analyzing.

Note: You can only choose one dimension at a time.  Dimensions currently available in the report are grayed out.  Those that belong to drill hierarchies but are not currently available in the report are displayed in black.

Bringing in new data using filters

 XE "Bringing in new data using filters"  - Use filters applied in drill mode as query conditions to bring in new data from CSU Database.  

To turn the drill filters option on:

1.  From the Tools menu choose Options.  The Options dialog box opens up.

2.  Click the Drill tab.

3.  Check the Apply Drill Filters box in the Drill Through section.  You can now retrieve the new data from CSU Database.  The dimensions already available in the report are grayed out.  These filters will be used as query conditions.

4.  Choose an object from the hierarchy and click OK.  The data is retrieved from CSU Database and the selected object is displayed in the table.  This object will be moved to the Drill toolbar.

Drilling Using Custom Hierarchies

 XE "Drilling Using Custom Hierarchies"  - You may find that the default order in which dimension objects are arranged in hierarchies is not optimal for your analysis needs, or that you need to drill on a hierarchy that has objects from different classes.  You can edit a hierarchy by changing the order of the dimensions it contains, by adding dimensions to it, and removing dimensions from it.  You can also rename a hierarchy, and even delete it.  You can also create your own hierarchies using dimensions available in the report or by using user objects.  

There are two types of Custom Hierarchies XE "Custom Hierarchies" :

• Pre-defined custom hierarchies that are set up by the universe designer and which can be re-used in other reports.

• Hierarchies you create which are only saved in the report you created them in.

Editing hierarchies

 XE "Editing hierarchies"  - The changes you make to a hierarchy that was created by a universe designer affect your work in drill mode only.  For example, if you delete a hierarchy, you can no longer use it in drill mode.  However, the hierarchy remains unchanged in the universe so you can still use the hierarchy to define scope of analysis when building a query on the universe.  The universe designer is the only person who can edit or delete hierarchies at the universe level.  

Analyzing Measures in Drill Mode

 XE "Analyzing Measures in Drill Mode"  - Measures display numeric data that is the result of calculations.

A report can contain two different types of measure objects:

• those created by the Universe designer and which are retrieved by a query (or measures retrieved by other data providers)

• measures created locally in the report

You can analyze measures in drill mode only if you have created them locally, based on data in the report that you are working on.

Note: For information on creating measure objects locally.  In drill mode, you can expand a measure to view its component parts in the report and analyze numeric data.

Collapsing a measure XE "Collapsing a measure"  is the opposite of expanding it.  Instead of viewing the measure's component parts, you display its aggregated values once more.

To expand a measure while working in drill mode XE "Expand a measure in drill mode" :
1.  Right-click the cell or chart element that displays the measure you want to expand.

2.  Choose Expand from the menu.  The measure's component parts are displayed in the block.  

To expand a measure while working in drill mode:
1.  Right-click the cell or chart element that displays the measure you want to collapse.

2.  Choose Collapse from the menu.  The data for the measure's component parts disappears.  

Note: If the Expand and Collapse commands are not available when you click on a measure, it means the variable was not created locally in the report and therefore cannot be analyzed.  

Making Copies of Reports While You Work XE "Making Copies of Reports"  
- This is handy to keep track of the different stages of your analysis you can make copies of your work as you go along.  Each copy you make of the report appears in a new tab inside the report.

To make a copy of a report XE "Copy a Report" :

• Click the Take Snapshot button on the Report toolbar.  A copy of the report appears in a new tab inside your report.  The name that appears in the tab is Report Name(n+1).  For example, if the report you copied is named Strength, the new report is named Strength (1).

Note: The filters displayed in the Drill toolbar when the snapshot was taken are turned into global report filters.

Chapter 4 - Templates and Standard Report Styles XE "Templates and Standard Report Styles" 
 - When you create a new report in BOA, you can either generate a standard report or choose from a set of templates.

Presentation Styles

 XE "Presentation Styles"  - Templates saves you time if you regularly use the same structure and formatting for reports.  You make the settings once and then re-use them in all your reports.  This section explains how to set up templates and to customize the standard report styles.  Customizing the styles used allows you to set a standard for your Region.

Most of the following information concerns users who design templates and styles.  If you are not designing templates and styles, all you need to know is how to:

• Apply a template to your report

• Use a template when you create a new report

• Apply standard report styles to a report

Standard report

 XE "Standard report"  - The default report is what you get when you first start using BOA.  Your data is displayed in a table with a report title and has the a basic format.  The table header is dark blue, the body cells are pale yellow with text and numbers in Arial size 10 font and black borders.  The table footer has a white background and free-standing cells have a black border.

You can customize and save attributes so that every time you create a new standard report, you will have your own colors, fonts, number styles and so on.

The settings that define the styles used to create a standard report are contained in a file called default.ret.  This file is stored in the BOA template folder.

Since the settings used to create a standard report are contained in one file, you can customize these settings once and then distribute this file to all users in the company.  Every time a user creates a standard report, the corporate formatting will be used.

Note: A standard report does not contain information on page setup such as margin sizes and page orientation.  If you want to include this information when you create a new report, use the template called Default.

Template

 XE "Template"  - A template is a special kind of BOA report that contains pre-defined styles and structure that you use as a foundation to create reports.  BOA comes with several templates for you to use and you can also create your own.  Your own templates enable you to apply the same customized styles and structure to your reports.  For example, if you always display your company's logo in the header of your reports, you can place the logo in the header of a template, then use the template when creating or formatting reports.  Templates contain a report structure and styles.  You can either use a template when you create a report or you can apply a template to an existing report.  

Structure - The structure of a report defines how the data is presented.  Your data can be presented in a cross-tab, a column chart, or it can have a master/ detail structure for example.  When you use a template, the data is displayed in the structure defined in the template.

Styles XE "Styles"  - The styles contained in a template define the page background and headers and footers style of the report.  

Setting a default report layout - You can set default options for the layout you want to use when you create new reports with the New Report wizard.  This allows you to always use the same template or to always create a standard report.

To set a default report layout:

1.  From the Tools, choose Options.  The Options dialog box opens.

2.  Click the New Report tab.

3.  Set the required option in the Report Layout section.

Tip:  If you have set a default universe and template, you can create reports without using the New Report Wizard.  When you click the New button or select the New command from the File menu, the Query Panel appears.  The Classes and Objects list presents the classes and objects of the default universe.  When you build the query, the data appears in the layout provided by the default template you set.

Always XE "Always"  creates a standard report.

Always uses the template you select in this list box to create a new report.  Prompts you to choose whether you want to use the standard report layout or select a specific template.  Displays a screen that allows you to select a template.  

Customizing Standard Report Styles

 XE "Customizing Standard Report Styles"  - You customize standard report styles in the Standard Report Styles dialog box.  You can open the Standard Report Styles dialog box with or without a BOA report open.

To open the Standard Report Styles dialog box:

• From the Tools menu, choose Standard Report Styles.  The Standard Report Styles dialog box opens.  The Standard Report Styles dialog box has two parts:

• Report Components XE "Report Components" .  The Report Components box on the left-hand side of the dialog box displays a list of the components that make up a report.  This includes tables, cross-tabs and cells as well as section and page components and breaks.  Each component in the list is given a name and is identified by an icon.

• Settings tabs XE "Settings tabs" .  When you click on an icon in the list the tabs on the right-hand side of the dialog box display the formatting options that can be set for the selected component.  These are the same tabs used on the format dialog boxes.  Some icons in the list have a plus sign next to them.  Click on the plus sign to expand the list.  What you can change depends on the type of report component.  The following buttons are available on the Standard Report Styles dialog box: 

Note: You cannot set chart attributes in the Standard Report Styles dialog box.

Edit settings

 XE "Edit settings" 
To edit settings in the Standard Report Styles window: 

1.  Select the item you want to modify in the Report Component list.  The tabs display the formatting options for the selected item.

2.  Make the required settings on the tabs.

3.  Click OK to save the changes and close the dialog box.

· Click Add a break or section level.  

· Click Delete to remove a break or section level from the list.  

· Click OK to Save the changes you have made and close the dialog box.  The changes are saved in the default .ret file.

· Click Cancel to close the dialog box without saving any changes you have made.  

· Click Apply to apply the changes you have made to the active report.  This button is not displayed if you do not have a report open.

· Click Help to open the on-line Help for a quick explanation of the dialog box options.  

· Click Tables  to edit the default formatting and page layout options for tables.

· Click Cross-tabs to edit the default formatting and page layout options for cross-tabs.

To edit general settings for tables, select the table icon in the list.  General settings include whether to display headers and footers, table orientation and how page breaks are handled.  

To edit the settings for the different elements that make up a table, click on the plus sign next to the table icon.  You can set different formatting for header, body and footer columns and rows.

Select the cross-tab icon to edit general settings for cross-tabs.  General settings include whether to display headers and footers and how page breaks are handled.  To edit the settings for the different elements that make up a cross-tab, click on the plus sign next to the cross-tab icon.  You can set styles for headers and footers, for the body cells of the cross-tab and for the four corners of a cross-tab.  

Chapter 5 - Breaks XE "Breaks"  

- This chapter explains how to break up data in tables and cross-tabs and describes the different options available to format and manage these breaks.  A break breaks up the data in a table or cross-tab by grouping the data according to a selected value.  This allows you to display all the data for each value of a dimension variable together, and allows you to display subtotals.  

Inserting and removing breaks

 XE "Inserting and removing breaks"  - You can insert and remove breaks with a simple mouse click.  The Insert Break button on the Report toolbar is a toggle button that inserts and removes breaks on data.

To insert a break:

1.  Click inside the column or row of data where you want to insert a break.

2.  Click the Insert Break button on the Report toolbar.  The data in the table is broken up and the Insert Break button is dimmed.

To remove a break XE "remove a break" :

1.  Click inside the data where the break has been inserted.  The Insert Break button on the Report toolbar is dimmed to show that there is a break on the selected data.

2.  Click the Insert Break button.  The Break is removed from the table or cross-tab.

Note: You cannot insert breaks on data in charts.

Formatting breaks

 XE "Formatting breaks"  - Some formatting and display options are applied by default.  You can edit these settings and set other options in the Breaks dialog box.

To display the Breaks dialog box:

1.  Right-click on the column or row where the break has been inserted.

2.  Choose Breaks from the menu. 

Note:  If no break has been inserted on a table or cross-tab, all the options in this dialog box are unavailable.

Showing headers and footers

 XE "Showing headers and footers"  - When you insert a break, a kind of mini table is created for each value of the variable.  You can choose whether or not you want to display a header and/or footer each mini table.  

To show headers and footers:

• To display a break header or footer, check the box next to Break Header or Break Footer in the Breaks dialog box.

• To hide a break header or footer, uncheck the box next to Break Header or Break Footer in the Breaks dialog box.

• Allows you to insert a new break.

• Remove a break by selecting it, then clicking Remove.

• You can set break attributes for the selected break in the Break Definition box.

• By default, a break is inserted on all values of the selected variable.  Clicking Values allows you to select only the values you want to include in the break.  To activate the Values button, first check the Value-Based Break check box.

• You can control the way a break is managed over page breaks in the Break and Pages box.  

• Clicking Edit allows you to apply the selected break on a different variable, or on more than one variable.  If the report contains at least two breaks on different levels, you change the break level.

Folding breaks

 XE "Folding breaks"  - You can choose to display only the break headers and footers in a table.  Other rows in the table will be hidden.

To display only the break headers and footers in a table:

• Check the Fold option in the Breaks dialog box.  

Merging cells 

- When you have inserted a break on a row or column, you have several columns or rows displaying the same value.  If you wish, you can display this value only once.  

To display value only once:
• Check Remove Duplicates on the Breaks dialog box.  

You can merge cells into one cell and display the name only once.  The name is centered over the columns or rows of data that it describes.  

To merge cells into one cell and display the name only once:

· Check Center Value Across Break on the Breaks dialog box or the Center Values Across Break button on the Formatting toolbar.  This button removes duplicate values, merges the cells and centers the value over the rows or columns it describes.

Across Break XE "Across Break"  

Tip:  If the column footer cell is empty when you center the value across the break, all rows, including the footer row are merged.  

If you do not want an empty footer cell to be merged:

1.  Type a character in the empty footer cell.

2.  Right-click on the footer cell and choose Format Cell from the menu.  The Format Cell dialog box opens.

3.  Click the Font tab.

4.  Set the font color to your choice, and click OK.

5.  Check the Center Values Across Break option in the Breaks dialog box.  The empty cells for each value will merge and the footer cells are untouched.

6.  Type a character in this cell and set the font color.  

Making a value-based break

 XE "Making a value-based break"  - You can apply a break on certain values in your table, instead of inserting a break on the whole column.  This breaks up the table to show subtotals:

To make a value-based break:

1.  Insert a break on a column you choose.

2.  Right-click on the column and choose Format Breaks from the menu.  The Breaks dialog box opens.

3.  Check the Value-Based Break check box.  When this box is checked, the Values button becomes available.

4.  Click the Values button.  The list of values box opens.  This box displays a list of all the values of the dimension.

5.  Select from the list and click OK.

6.  Click OK again to close the Breaks dialog box and view the result.

Organizing multiple breaks

 XE "Organizing multiple breaks"  - You can insert up to nine breaks on a table or cross-tab.  When you have more than one break in a table or cross-tab, the breaks are assigned levels.  BOA assigns level 1 to the first break you insert, level 2 to the second and so on.  You can rearrange these levels in the Breaks dialog box and set different options for the different breaks.

To reorganize the order in which breaks are applied:

1.  Right-click on a column or row that contains a break and choose Format Breaks from the menu.  The Breaks dialog box opens.

2.  Click on the break name in the list and click the Edit button.

3.  Set the order you want the break to be applied and click OK.  The list of breaks inserted in the selected table and the order in which they are applied.  Sets break order.  

Managing breaks over multiple pages

 XE "Managing breaks over multiple pages"  - When a table covers more than one page, you can set the tables to not split in a poor location.  You can also keep elements such as column and row headers repeating on new pages.  The following options can be set in the Break and Pages section of the Breaks dialog box.

To open the Breaks dialog box: 

• Right-click on a row or column that contains a break and choose Format Breaks from the menu.

• Check Avoid Page Break, keep each break section of the table or cross-tab on the same page.

• Check Start a New Page to display each part of the table or cross-tab created by a break on a separate page.  

• Check Repeat the Header on the New Page to repeat the header on each new page if a table or cross-tab extends over more than one page.

• Check Repeat Break to place the Value on 

• Check New Page Repeat to place the current break value on the new page.

Chapter 6 - Advanced Report Building

 XE "Advanced Report Building"  

- This section describes how to add breaks to financial reports and tables, add page breaks, apply view / hide conditions , use the report Map and apply advance printing controls.  Covers how to create financial reports with format breaks and cell breaks; Manage tables that break over pages; display blocks in a report according to condition that you specify; how to use the Report manager Map to navigate around reports quickly and move components; and apply advance printing controls.

Advanced Finical Reports

 - A financial block is a table block that has added formatting to the structure and layout.  It changes the orientation of the rows and columns; add format breaks; and adds cell breaks.

Changing Data Orientation XE "Changing Data Orientation" 
To change data orientation:

1.  Click File and choose the New option, to create a blank report.

2.  Click Data and choose New Data Provider to display the New Data Wizard.

3.  Create a new data provider using the Regional Report Data Universe.

4.  In the Query Panel, drag and drop the objects you choose over to the Result Objects panel.

5.  Click Run.

6.  In the Report Manager panel, use the <Ctrl> key to select drag the same objects as above and drop them in the Report area to build a table.

7.  Select the table.

8.  Click Format and choose the Table option to open the Table Format dialog.

9.  Click on the General tab.  (Table Format box)

10.  Change the Orientation setting from Down to Across to rotate the table through 90 degrees and click OK.

Note:  You can also rotate the table using the Rotate Table button on the Report Toolbar

11.  Save the report as with a different name.

Changing the Orientation and the Order of Rows XE "Changing the Orientation and the Order of Rows"  

- The cross-tab feature can also be use to change the orientation of the table and the order of the rows at the same time.  Using "Slice and Dice" you can reorder the rows.

To change the orientation of the table and the order of the rows at the same time:

1.  Insert a report in the current document and create a table.

2.  Click on the Slice and Dice button to open the Slice and Dice Panel.

3.  Drag an object above the line.

4.  Click Apply to produce the reordered and rotated financial block.

5.  Click on the Slice and Dice button again to close the Slice and Dice Panel.

Format Cell

 XE "Format Cell"  - You can format cells using padding characters and indent to highlight different level of detail.

To format cells using padding characters and indent to highlight different level of detail:

1.  Click on (highlight) a column to reformat.

2.  Right click the mouse pointer and select Format Cell.

3.  Click the Alignment tab.

4.  In the Horizontal controls area, select the Left alignment.

5.  In the Settings area, select Fill and type a period as the fill character.

6.  Click OK.

Outlining and Folding Reports

 XE "Outlining and Folding Reports" 
Breaks  XE "Breaks"  - You can edit the settings for breaks you insert in tables and cross-tabs.  Define up to nine different break levels with different attributes set for each level.  

Adding and deleting break levels

 XE "Adding and deleting break levels"  - When you add a new break level, BOA inserts the new level below the level selected when you click the Add button.  The newly inserted break level has the same style settings as the break level under which it is inserted.

To add a break level:

1.  Select the Break level under which you want to add a break.

2.  Click the Add button.  A new break level is added to the list.

To delete a break level:

1.  Select the break level you want to delete in the list.

2.  Click the Delete button.  

3.  Click on the Breaks icon to edit settings that will apply to all breaks in the report.  

4.  Click on the Level n icon to edit settings that will apply to all level n breaks in the report.  

5.  Open the Level n folder and click on Down or Across to edit settings that apply only to the selected item.  

Sections

 XE "Sections"  - You can set different attributes for up to nine different sections in a report.  You can set attributes for the cells that are displayed at the top of each section and that contain the master value and for the background shading of the section.  

Adding and deleting sections

 XE "Adding and deleting sections" - When you add a new section level, BOA inserts the new level below the level selected when you click the Add button.  The newly inserted section level has the same style settings as the section level under which it is inserted.

To add a section:

1.  Select the Section level under which you want to add a section.

2.  Click the Add button.  A new section is added to the list.

To delete a section:

1.  Select the section you want to delete in the list.

2.  Click the Delete button.  Click on the Section icon to edit settings that apply to all the section levels in your report.

To Edit settings for a particular section XE "Edit settings for a particular section" , click on the Level n icon and make the required changes.

To edit the settings for the different elements that make up a section, click on the plus sign next to the Level n icon to open up the section list.

Click on Master Cell to edit settings for the master cell.

Click on Section Area to edit the background shading for the selected section.  

Pages - You can edit the background shading for the report page.  Set the same shading for the whole page or set the shading for the page header, page body and page footer separately.

Free-standing cells

 XE "Free-standing cells"  – Click on the cell icon to edit settings for free-standing cells.  Select the Page icon to set the same shading for all three page elements.

To edit the settings for the different elements that make up a page, click on the plus sign next to the page icon.  You can set different shading for the page header, the main section (the page body) and the page footer.  

Applying standard report styles

 XE "Applying standard report styles"  - You can create a new standard report using your custom standard report style settings or you can apply your custom styles to existing reports.  You can apply your custom standard report styles to the whole report or to a selected item.

To apply standard report styles to the report-  From the Format menu, choose Report and then Apply Standard Style. 

Applying standard report styles XE "Applying standard report styles"  to a selected component - You may want to only apply a standard report style to a selected table, cross-tab or cell, for example.  When you apply a standard report style to a selected component, only the formatting attributes are applied.  Pagination and break settings are ignored so that your report layout is not disorganized.

To only apply a standard report style to a selected table, cross-tab or cell:

1.  Make sure the Report Manager window is open.

2.  Click on the Map tab.

3.  Click the Structure option button.  A list of all the components in the report is displayed.

4.  Right-click on the component you want to apply the standard report style to.

5.  Choose Apply Standard Style from the menu.  

Tip:  For a section or cell, you can right-click on the component you want to apply the standard report style to and choose Apply Standard Style from the menu.  

Making sure everyone uses the same standard report styles 

- Any changes made to the standard report style settings are saved in the default.ret file.  This allows you to customize the standard report styles once using your corporate formatting and then distribute the default.ret file to all users via the repository.  

To make sure everyone uses the same standard report style:

1.  Edit and save the standard report styles on your computer.

2.  Make sure all users are using the same default.ret file.  There are several ways of doing this:

• send the default.ret file to all users and have them copy it into their BOA template folder

• change the template folder location to point to the folder containing the customized default.ret file; you can also do this during installation

• use a master/ shared installation

Note:  If BOA cannot find the default.ret file, it will re-create one using the default application settings and the standard report created may not reflect any changes you have made.  Make sure the default.ret is in the Template folder in the BOA folder.  If you have changed the default location of your templates in your BOA options, make sure the default.ret file is in this folder.  

Using Templates

 XE "Using Templates"  - You can use a template in the following situations:

• When creating a report.  The New Report Wizard includes a dialog box that enables you to view and select the template you want to use.  The styles and structure of the template are applied to the new report.

• When formatting an existing report.  When you apply a template you can choose to apply the template styles only, or to apply the styles and the structure.

If you choose to apply the styles and the structure, you can also manually replace certain variables in the template with certain variables from the report.  

Note: Universe Designers can apply formats (Alignment, Font, Border, Shading) to objects when creating universes.  These formats are used even if you use a template with different formats.

Creating a template XE "Creating a template" 
To set up a report to use as a template with all the required formatting, margin settings etc.

1.  Make sure the report that you want to use as a template is active.

2.  Choose Save As from the File menu.  The Save Report As dialog box appears.

3.  Click the Save As type box, then click BOA (Business Objects) Templates (*.ret).

4.  Select the folder in which you want to save the template.  If you want the template to be available in the New Report Wizard, you must save it in the Template folder in the Business Objects folder.

5.  Type the name of the template in the File Name box, then click OK.  Templates are saved as .ret files.  

Changing the default template folder XE "Changing the default template folder" 
To set a default folder other than Template in which to save your templates:

1.  From the Tools menu choose Options.

2.  Click on the File Location tab.

3.  Click User Templates.

4.  Click the Browse button to select the folder you want to use.  

Applying a Template

 XE "Applying a Template"  - You can quickly format an existing report by applying a template.

To format an existing report by applying a template:

1.  Display the report you want to format.

2.  From the Format menu, choose Report then Apply Template.  The Apply a Template dialog box appears:

3.  Select a template from the Available Templates list.

Note:  If the template you want to use is located in a folder other than the one set in the File Locations tab on the Options dialog box, click Browse.  A dialog box appears, and enables you to select the folder where the template is located.

4.  If you want to apply the template styles and structure to the report click OK.  BOA applies the template to the report.

5.  In the Template Options dialog box, click Apply Only the Style if you want to apply the template's fonts, colors, page background and header/footer.  Only the options in the Style box are now available:

6.  If you do not want to apply the background or header/footer, deselect Keep Background and Keep Header and Footer, respectively.

7.  Click Apply Structure and Style if you want to apply the template's style and its structure (blocks, sections) to the report.  

This option:

• Activates the options in the Structure box.

• Enables you to replace variables in the template with variables from the report.

8.  Click OK, then click Apply or OK in the Apply a Template dialog box.  

Replacing variables in a template with variables from a report - Variables are automatically replaced if:  XE "Replacing variables in a template" 
• You apply a template without setting options.

• You apply a template's structure and style, and leave the Replace Variables Automatically option checked.  

You can replace variables manually XE "Replace variable manually" .  

To manually replace variables:

1.  From an open report, choose Apply Template from the Format menu.

2.  Click Options, and in the Template Options dialog box that appears, click Apply Structure and Style.  The options in the Structure box are now active.

3.  Uncheck Replace Variables Automatically, then click Define.  The Replace Variables dialog box appears.

4.  In the Report Variables box, click the report variable with which you want to replace the template variable.

5.  In the Template Variables box, click the template variable to be replaced by the report variable, then click Replace.  The variable from the report appears in the Template Variables box:

6.  Repeat step 5 to replace other variables, then click OK.

7.  To undo a replacement, click the variable in the Template Variables box, then click Remove.

8.  In the Template Options dialog box, click OK.  You return to the Apply a Template dialog box.

9.  Click Apply or OK.  BOA applies the template to the report.

Query Conditions

Editing the query to bring in new data - If the lowest level of detail you need is not currently available in the report, you can drill through to CSU Database directly from drill mode.  

Templates and Standard Report Styles XE "Templates and Standard Report Styles" 
- When you create a new document in BOA, you choose the type of report layout your data will be displayed in.  You can either generate a standard document or choose from a set of templates.

Standard document - When you install BOA and create your first standard document / report, your data is displayed in a table with a document title and has the default application formatting.  The table header is dark blue, the body cells are pale yellow with text and numbers in Arial size 10 font and black borders.  The table footer has a white background and free-standing cells have a black border.  You can customize and save these attributes so that every time you create a new standard document, you will have your own colors, fonts, and number styles.  The settings that define the styles used to create a standard report are contained in a file called default.ret.  This file is stored in the BOA template folder.

Since the settings used to create a standard report are contained in one file, you can customize these settings once and then distribute this file to all users.  Every time a user creates a standard report, the corporate format would be used.

Note:  A standard document does not contain information on page setup such as margin sizes and page orientation.  If you want to include this information when you create a new report, use the template called Default.

Template

 XE "Template"  - A template is a special BOA report that contains pre-defined styles and structure that you use as a foundation to create documents / reports.  BOA comes with several templates for you to use and you can also create your own.  Your templates enable you to apply the customized styles and structure to your reports.  For example, if you always display your Region’s logo in the header of your reports, you can place the logo in the header of a template, then use the template when creating or formatting reports.  Templates contain a report structure and styles.  You can either use a template when you create a report or you can apply a template to an existing report.  

Structure XE "Structure"  - The structure of a document defines how the data is presented.  Your data can be presented in a cross-tab, a column chart, or it can have a master / detail structure for example.  When you use a template, the data is displayed in the structure defined in the template.

Styles - The styles contained in a template define the page background and headers and footers style of the report.  

 Setting a default report layout 

- You can set default options for the layout you want to use when you create new reports with the New Report wizard.  This allows you to always use the same template or to always create a standard report.

To set a default report layout:

1.  From Tools, choose Options.  The Options dialog box opens.

2.  Click the New Document tab.

3.  Set the required option in the Report Layout section.

Tip:  If you have set a default universe and template, you can create reports without using the New Document Wizard.  When you click the New button or select the New command from the File menu, the Query Panel appears.  The Classes and Objects list presents the classes and objects of the default universe.  When you build the query, the data appears in the layout provided by the default template you set.

Always 

• Creates a standard document.  

• Uses the template you select in this list box to create a new document.  

• Prompts you to choose whether you want to use the standard report layout or select a specific template.  

• Displays a screen that allows you to select a template.  

Customizing Standard Report Styles XE "Customizing Standard Report Styles" 
Customize standard report styles in the Standard Report Styles dialog box.  You can open the Standard Report Styles dialog box with or without a BOA report open.

To open the Standard Report Styles dialog box:

• From the Tools menu, choose Standard Report Styles.  The Standard Report Styles dialog box opens: 

The Standard Report Styles dialog box has two parts:

• Report Components - The Report Components box on the left-hand side of the dialog box displays a list of the components that make up a report.  This includes tables, cross-tabs and cells as well as section and page components and breaks.  Each component in the list is given a name and is identified by an icon.

• Settings tabs - When you click on an icon in the list the tabs on the right-hand side of the dialog box display the formatting options that can be set for the selected component.  These are the same tabs used on the format dialog boxes.  Some icons in the list have a plus sign next to them.  Click on the plus sign to expand the list.  

Note: You cannot set chart attributes in the Standard Report Styles dialog box.  What you can change depends on the type of report component.  

Buttons available on the Standard Report Styles dialog box: 

Editing settings XE "Editing settings" 
To edit settings in the Standard Report Styles window: 

1.  Select the item you want to modify in the Report Component list.  The tabs display the formatting options for the selected item.

2.  Make the required settings on the tabs.

3.  Click OK to save the changes and close the dialog box.

• Click Add to add a break or section level.  

• Click Delete to remove a break or section level from the list.  

• Click OK to save the changes you have made and close the dialog box.  The changes are saved in the default.ret file.

• To Cancel, close the dialog box without saving any changes you have made.  

• Click Apply to apply the changes you have made to the active report.  This button is not displayed if you do not have a report open.

• Click Help to open the on-line help for a quick explanation of the dialog box options.  

Chapter 7 - Slice-and-Dice XE "Slice-and-Dice"  

Slice-and-dice mode enables you to analyze data from different perspectives.  For example, you can switch the position of data in the report by building cross-tabs from tables, or 3-D matrix charts from 2-D charts.  You can also use slice-and-dice mode to:

Work with master/detail reports XE "Work with master/detail reports" .

    Apply, edit and remove breaks, filters, sorts and calculations on data.  

    Rename, delete and switch between tables, cross-tabs and charts.

Slice-and-dice is enabled by the Slice and Dice Panel

You can manage blocks in slice-and-dice mode in the following ways:

By renaming them.  

BOA provides a default name for each block, Table 1 for example, but you can change these for more pertinent names.

    By deleting them from the report.

    By turning tables and cross-tabs into charts, and vice versa.

In the Slice and Dice Panel, you perform these tasks by clicking a block's tab with your right-mouse button.  A pop-up menu appears, on which you click the command for the task you want.

The Slice and Dice Panel displays all the data that is available for use in a report, and shows which data is already displayed in the report.  The combination of these two features makes it easy to add previously undisplayed data to a report, and remove data that is already displayed.  Also, you can move data inside a table, cross-tab or chart with simple mouse clicks.

You analyze data by looking at it from different levels of detail and from different viewpoints.  Through your analysis, you gain new information and thereby answer questions.

BOA enables you to perform analysis thanks to drill mode, an optional module of BOA and slice-and-dice mode.

In BOA, you analyze data that is stored locally in the report, not data that is stored on a remote database.  To have the data you need for analysis at your disposal, you can define scope of analysis when you build a query for the report.  

The Slice and Dice Panel displays all the data that is available for use in a report, and shows which data is already displayed in the report.  The combination of these two features makes it easy to add previously undisplayed data to a report, and remove data that is already displayed.  Also, you can move data inside a table, cross-tab or chart with simple mouse clicks.

Slice-and-dice mode provides a simple solution for working with cross-tabs and 3-D matrix charts.  By dragging and dropping icons in the Block Structure box of the Slice and Dice Panel, you can structure tables and 2-D charts as cross-tabs and 3-D matrix charts respectively.  You can also move data inside cross-tabs and 3-D matrix charts, for example by swapping the data that appears in rows in a cross-tab with the data that appears in columns.

The Slice and Dice Panel makes it easy to work on master/detail reports.  You can structure existing reports as master/detail reports, remove the master, use a different master, and build master/master/detail reports.  

In the Slice and Dice Panel, the Section box displays the master(s) in the master/detail report.  You work on master/detail reports by dragging icons to, from and inside the Section box.

If you click an icon in the Section box with your right-mouse button, a pop-up menu appears.  You can use the commands on this pop-up menu to deactivate sections of master/detail reports.  This feature enables you to recalculate the report without removing data from it, and is particularly useful in reports which contain multiple blocks.  

Structure an existing report XE "Structure an existing report"  as a master/detail report in slice-and-dice mode

1    Open a report.

2    Display the Slice and Dice Panel.

3    Drag the icon of the variable you want to use as master to the Section box, then release your mouse button.

4    Click Apply.

Note:  The icon that you drag to the Section box can be originally located in the Available Variables box or in the Block Structure box.

Use a different master in slice-and-dice mode

1    Open a report.

2    Display the Slice and Dice Panel.

3    Drag the icon of the variable you want to use as master to the Section box, then release your mouse button.

4    Drag the icon that you no longer want to use as master either to the Available Variables box, or to the Block Structure box.

5    Click Apply.
Notes:  If you drag the icon to the Available Variables box, you remove the corresponding data from the report.  If you drag it to the Block Structure box, you display it in the block (table, chart or cross-tab).

    You can swap icons between the Section box and the Block Structure box.  To do this, hold down your Shift key as you drag one icon, and release your mouse button when it is located on top of the icon with which you want to swap it.

The Slice and Dice Panel displays all the data that is available for use in a report, and shows which data is already displayed in the report.  The combination of these two features makes it easy to add previously undisplayed data to a report, and remove data that is already displayed.  Also, you can move data inside a table, cross-tab or chart with simple mouse clicks.

Slice-and-dice mode provides a simple solution for working with cross-tabs and 3-D matrix charts.  By dragging and dropping icons in the Block Structure box of the Slice and Dice Panel, you can structure tables and 2-D charts as cross-tabs and 3-D matrix charts respectively.  You can also move data inside cross-tabs and 3-D matrix charts, for example by swapping the data that appears in rows in a cross-tab with the data that appears in columns.

The Slice and Dice Panel makes it easy to work on master/detail reports.  You can structure existing reports as master/detail reports, remove the master, use a different master, and build master/master/detail reports.  

In the Slice and Dice Panel, the Section box displays the master(s) in the master/detail report.  You work on master/detail reports by dragging icons to, from and inside the Section box.

Finally, if you click an icon in the Section box with your right-mouse button, a pop-up menu appears.  You can use the commands on this pop-up menu to deactivate sections of master/detail reports.  This feature enables you to recalculate the report without removing data from it, and is particularly useful in reports which contain multiple blocks.  

Deactivate a section of a master/detail report XE "Deactivate a section of al report" 
1    Open a master/detail report.

2    Display the Slice and Dice Panel.

3    Click the tab of the block that you want to recalculate.

4    In the Section box, with your right-mouse button, click the master of the section that you want to deactivate.

5    Click "Deactivate this section" on the pop-up menu that appears.

6    Click Apply.

Reactivate a section of a master/detail report XE "Reactivate a section of a report" 
1    Open a master/detail report.

2    Display the Slice and Dice Panel.
3    Click the tab of the block that you want to recalculate.

4    In the Section box, with your right-mouse button, click the master of the section that you want to reactivate.

5    Click "Activate this section" on the pop-up menu that appears.

6    Click Apply.

Note:  You can also perform this task by selecting and dragging the block back to its original section.  To do this, hold down your Alt key and click inside the block.  Position the cursor on the block's border.  When the cursor changes to a cross, click the border.  Hold down your mouse and drag the block to its original section.  When you release the mouse button, BOA dynamically recalculates the data in the block.

Remove a master in slice-and-dice mode XE "Remove a master in slice-and-dice mode" 
1    Open a master/detail report.

2    Display the Slice and Dice Panel.

3    Drag the icon of the variable in the Section box either to the Available Variables box, or to the Block Structure box, then release your mouse button.

4    Click Apply.

Note:  If you drag the icon to the Available Variables box, you remove the corresponding data from the report.  If you drag it to the Block Structure box, you display it in the block (table, chart or cross-tab).

Delete a block in slice-and-dice mode XE "Delete a block in slice-and-dice mode" 
1    Open a report.

2    Display the Slice and Dice Panel.

3    In the Block Structure box, with your right-mouse button click the tab of the block you want to delete.

4    Click the Delete command on the pop-up menu that appears.

5    Click Apply.

Tip:  You can delete two or more blocks at the same time.  To do so, hold down the Ctrl key, click the tab of each block, then click your right-mouse button.  Click the Delete command on the pop-up menu that appears.

Note:  The Delete command is unavailable if the report contains only one block.  

Turn a chart to a table or a cross-tab in slice-and-dice mode XE "Turn a chart to a table or a cross-tab in slice-and-dice mode" 
1    Open a report.

2    Display the Slice and Dice panel.

3    In the Block Structure box, with your right-mouse button click the tab of the chart that you want to turn into a table or a cross-tab.

4    Click the Turn to Table command on the pop-up menu that appears.  If you are working in a 3-D matrix chart, the command is Turn to Cross-tab.

5    Click Apply.
Turn a table or a cross-tab to a chart in slice-and-dice mode XE "Turn a table or a cross-tab to a chart in slice-and-dice mode" 
1    Open a report.

2    Display the Slice and Dice Panel.

3    In the Block Structure box, with your right-mouse button click the tab of the table or cross-tab that you want to turn into a chart.

4    Click the Turn to Chart command on the pop-up menu that appears.

5    Click Apply.

Chapter 8 - Sharing information

 XE "Sharing information"  

– Share the documents and reports you have created with other users in your Region by sending them directly to selected individuals or groups, or by publishing them as corporate document.  When you distribute reports in these ways, you use the BOA Repository.  The repository stores the documents (reports) you send so other users can retrieve and view them.  It also stores information about the reports, such as name of sender, date and time, and also which users have the right to retrieve and view a document / report.

Repository XE "Repository"  is a central data-store that maintains security and facilitates the management and sharing of resources.  A repository has three domains; the Universe, the Security and Document domains.  The Repository is created by the Supervisor using the Supervisory Module of BOA.

Retrieving reports that other BOA users have sent

 XE "Retrieving reports that users have sent" .  You can use a program called “Broadcast Agent” to send reports for scheduled processing.  For information on sending, retrieving, printing, and publishing and scheduling reports, see the section on InfoView.  You can open an electronic version of this guide directly from the BOA Help menu.

Export To External Format XE "Export To External Format" 
You can send data to an external user via another format such as Excel using this process.

1.  Open a report

2.  Select the view data icon        


3.  When the Data Manager window opens select the Export button.

This screen opens up giving you the choice of available formats to export your report to a local file.

4.  Click OK.

Document exchange

 XE "Document exchange" .  With BOA - Broadcast Agent you can process documents and send them to other users.

Custom scripts XE "Custom scripts"  - A script that performs a non-standard task such as informing recipients by e-mail that Broadcast Agent has failed to refresh a document.  Microsoft Visual Basic for Applications (VBA) is the language used.  Broadcast Agent automatically converts scripts to VBA macros when processing documents.

Updating scripts that send e-mail via Microsoft Outlook - You could use Document Agent Server to send e-mail via Outlook, for example, to inform recipients that Document Agent Server had successfully processed a document.  You can continue to customize document processing with e-mail by attaching VBA macros to documents that you send. 

Scheduling BOA documents XE "Scheduling BOA documents"  - You can only “schedule” BOA documents from BOA.  InfoView users can view, refresh, print, publish and save BOA documents over the Web, but cannot schedule them. 

Broadcast Agent XE "Broadcast Agent"  - is used to process documents containing user objects - The user objects will be ignored, meaning that any data you need from these objects will not appear in the document.  Broadcast Agent is used to process documents containing prompts - BOA displays the prompt when you send the document; Broadcast Agent then uses the values you entered when processing the document.

Mail XE "Mail"  

With an interface between BOA and any Messaging Application Programming Interface (MAPI) compliant messaging system such as Microsoft Exchange you send documents by e-mail.  This feature is available only if you have a mail service for Windows 95, Windows 98 or Windows NT installed on your computer.  You can distribute information with BOA, by Seamlessly sharing BOA and WebIntelligence documents through the BOA repository.  With WebIntelligence, you can view and retrieve documents that other users have published.  You can also schedule documents to run using Broadcast Agent to automate document processing and distribution.

Web Publishing XE "Web Publishing" 
“Web publishing” is the communication of information by making documents available on the World Wide Web (www). This involves:

• Converting documents into Hypertext Markup Language (HTML), the format that is recognized by Web browsers.

• Placing documents on a Web server, so that people browsing the Web or working on an intranet can access them.

Note: In this chapter, the term “documents” refers to BOA .rep files.  A document can contain one or many reports.  Each report has its own tab inside the document.  The Web is a good way to share information.  It allows online users to view and download up-to-the-minute information.  You can publish documents externally.  The following examples show how.

Save you document in HTML format.

Saving HTML Documents XE "Saving HTML Documents"  – With the advent of the Internet, the “browser” has become an invaluable tool for viewing content.  In BOA we can save a document as HTML, allowing users, without the BOA program, to view a document using their browser.   HTML (Hypertext Mark-up Language) is a standard format for WEB pages.

To save a BOA Document as HTML XE "To save a BOA Document as HTML" :

1.  From the File menu select Save as   The Save document dialog will appear.

2.  Type the name you want the document saved as.

3.  From the “Save as Type” drop down list, select HTML

4.  Click the Save push-button.

You can use BOA internally to report on weekly performance.  By publishing your documents on your Intranet, the workforce can get the information they need using their Web browser. 

Publishing to Microsoft Channels XE "Publishing to Microsoft Channels" 
BOA lets you publish documents to channels web sites designed to deliver content from the Internet to your computer. You subscribe to a channel using Microsoft Internet Explorer, and can choose to have the information on the channel brought to you every time it changes.  People who use your Web site or Intranet can thus subscribe to documents.  Every time you refresh the documents, you automatically deliver the information to your subscribers.

World Wide Web XE "World Wide Web" 
You can communicate information to others inside your organization and to those outside your organization.  BOA lets you publish your information around the globe using the World Wide Web.

Publishing documents on the www and Microsoft channels.

To publish documents on the www they must be saved as an HTML file. 

1.  Open the document.

2.  Click the Save As command on the File menu.

3.  In the Save Document As dialog box, move to the folder in which you want to save the document, then type a name in the File Name box.  

Note:  These steps are optional since the default is the UserDocs folder and a name for the document.  If this is not the first time you have saved the document, BOA proposes its existing name in the File Name box.

4.  Click HTML format *.htm in the Save as type list box, then click Save.

5.  In the Save Options dialog box, select the options you want for the HTML document, then click OK.

Tips - You can enter HTML code in report cells, for example to place a hypertext link in a report published on the web. 

To enter HTML code in report cells, click inside the cell and type the code.  To ensure that the code is read as code and not as simple text, click the cell then select the Read As HTML option (Number tab, Cell Format dialog box, Cell command, Format menu).  

By sending documents to Broadcast Agent, you can save them in HTML format and publish them on your web server. 

This is different than sharing documents with InfoView users.  When you Web publish a BOA document, you use BOA to create your documents, you publish them in HTML format, then you post those HTML versions on a corporate intranet, extranet, or the www.  On the other hand, BOA users can share documents seamlessly with INFOVIEW users via the repository.  The first time an INFOVIEW user asks to view a BOA document in HTML format, the server converts the document into HTML format at that time, then displays it in the user’s Web browser.

A copy of that file remains in the browser’s cache until the end of the INFOVIEW session.  That way, the document can be displayed more quickly should the user want to view the document again.

Web publishing process XE "Web publishing process" 
1.  Generating an HTML document - The first step in Web publishing is to generate an HTML version of your document.  Then you can do either of the following:

• Save the document by using the Save As command on the File menu.

• Send the document to Broadcast Agent.

Broadcast Agent handles scheduled processing. 

Tip: You can add your own HTML to documents.  For example, you can include a jump to a Web page.  BOA saves the code as HTML and the jump is available when you publish the document. 

2.  Placing the HTML document on a Web server

The second step in Web publishing is to place the document on a Web server.  The following table shows how the way you do this depends on the way you completed the previous step:

If you used the Save As command you must place the document on the server by moving it through the file system.  If you sent the document to Broadcast Agent, then you can have Broadcast Agent automatically place the document on a server you specify. 

In documents with many reports, you can specify the ones you want in the .htm document  You can include all, some or only one report in the .htm document.  Each report you include has a corresponding tab in the browser.

You can let other users download the documents to BOA, but you can also choose not to let other users download the document.

Graphics (charts and pictures) are converted to the .gif format in BOA.

Formats (fonts, borders, background colors, etc.), appear in the .htm document as they do in Business Objects Font sizes, however, they are approximate.  Report layouts stay the same.

You can automatically load the published .htm file at regular intervals.  You can specify the interval at which you want the document to be reloaded.  Any changes in the document in BOA will be mapped to the published file.

There is a way of including jumps to report sections.  With BOA, you can publish a report in one HTML page, or on a one-page-per section basis.  

HTML objects XE "HTML objects" 
Universe designers can create HTML objects in BOA universes.  An HTML object maps to columns in a relational database, just like any other object.  Its added feature is an HTML “wrapper” that enables users to drill down in published documents.  The universe designer creates an object.  When included in a query, this object returns a list.  When the user publishes the document containing data returned by this object, anyone viewing the published document can click on an item in that object’s list and drill to find the object’s exact location.  The object definition contains the SQL required to retrieve the data from the database, plus HTML that provides a dynamic link to the image files:  
     ‘<a href=”web/&Object.object_name’.gif”>’Object.object_name’</a>’

Note:  Data retrieved by HTML objects is underlined in published documents, which indicates that you can click a value to drill down. 

Saving Documents in HTML Format XE "Saving Documents in HTML Format" 
When you save a document in HTML format, you can allow other users to download the document.  This allows quick and easy distribution, especially on an Intranet. You publish a document once, and all your users can download it; and it downloads all the data in the document, which means that users can continue to work on the document on their own computer.  

A user can perform analysis to view the results they want and also refresh the data, provided they have the right to use the connections required.  BOA also provides formatting options to ensure that the formats you have applied to your document appear in the HTML version.  

Navigation options allow users to find the information when viewing published documents on the Web.  This section provides information on character support, and describes how to 

• Save a document in HTML format

• Allow other users to download the published document

• Select formatting options

• Set up navigation to provide links to report sections.

Special characters in HTML XE "Special characters in HTML" 
If you’re planning to distribute information over the www by saving BOA documents in HTML format, note the following limitations in characters that may be in your document data, document names and report tab names.  

Characters supported in document data 

Your documents may contain data that may appear in Euros, or other “special” characters.  These special characters are supported in HTML if the browser used also supports them.  If the browser does not support special characters, they are displayed as Unicode symbols.

Characters supported in document names and report tab names

The characters that can be used in the names of documents you save as HTML files depend on your operating system.  If the operating system supports a character, then you can use it in the name of your HTML document.  Characters not supported by your operating system will be replaced by an underscore (_).  For example, if the space character is not supported, My Document.rep becomes My_Document.htm.  Any characters other than A-Z and 0-9 that you use in report tab names will be replaced by an underscore in the HTML document.  So, if your document contains a tab which you renamed to Grades%, this will appear as Grades_ in the HTML document.  The underscore (_) replaces the % sign.

Note: Your organization may be planning a BOA deployment on different operating systems.  What one operating system supports, another may not.  For information on operating system support, refer to the Deployment Guide.

Saving a document in HTML format
To save a document in HTML format:

1.  Make sure the document is open in BOA.

2.  Select the Save As HTML command on the File menu.  The Save As dialog box appears. The HTML format (*.htm) option is already selected in the Save as type box:

3.  Move to the folder in which you want to save the document, type its name in the File name box.

4.  Click Save.  The HTML Options dialog box appears:

5.  In the Save group box, select an option to specify which reports from the document you want to save in HTML format:

• Current Report saves only the report that is displayed on your screen.

• All Reports in Document saves all the reports in the document.

• Select Reports lets you select just the reports you want.

6.  Check BOA Document to allow other users to download the document.

7.  Select formatting options in the Format box. 

8.  Select an option in the Generate HTML group box.  These options affect the way users can navigate through the document in their Web browser.

9.  To save the HTML document with the options you selected, click OK.

• BOA makes a copy of the document and saves it in HTML format.

• The original document remains on your screen.

Files and folders created with HTML documents

 XE "Files and folders created with HTML documents" 
When you save a document in HTML format, BOA creates a number of files and folders.  These files and folders manage graphics, navigation, downloading, frames and multiple reports in the same document.  They are all located in the UserDocs folder, and are described in the following table.

Web Publishing with Broadcast Agent XE "Web Publishing with Broadcast Agent" 
Broadcast Agent provides scheduled (or batch) processing of documents. Broadcast Agent can refresh, print and distribute documents at specified times or intervals.  It can also save documents in HTML format and publish them on a Web server.  This section describes how you, the end user, can have Broadcast Agent publish your documents on a Web server.  

Broadcast Agent provides powerful and reliable Web publishing. It refreshes documents at set intervals, so that the data published on the Web is always up-to-date.

To Web publish a document with Broadcast Agent

You can only publish a document with Broadcast Agent if the following conditions are met:

• Your supervisor has granted you access to Broadcast Agent.

• You are working online.

a.  You send a document to Broadcast Agent by clicking the Send To Broadcast Agent button on the Document Exchange toolbar in BOA.

b.  You specify the Web server on which Broadcast Agent will publish the document, and specify refresh intervals (e.g., every day at midnight). You also set HTML options to control the display of the published document (e.g., in frames, with or without download, etc.).

c.  Broadcast Agent converts the document to HTML format, publishes it on the Web server, and refreshes it at the intervals you specified. At each refresh, Broadcast Agent brings up-to- the-minute data from the database to the published document.

• The document is open in BOA.

You can submit only one document at a time, so if several documents are open, only the active document is sent.

Here are the steps:

1.  Click the Send to Broadcast Agent button on the Document Exchange toolbar.  The Send Document to Broadcast Agent dialog box appears.

2. In the General tab, select the server and the document’s priority, and write a description of the document if you like.

3.  In the Distribution tab, check Distribute via Web Server.  The field below the checkbox indicates the path to the folder that will receive the published document.  By default, BOA uses a variable, $BO_FOLDER_ON_SERVER\UserDocs, which automatically sends documents to the folder in which BOA is installed on the server.  You can specify a different folder on a different computer by clicking Browse, or by typing a path, e.g., \\HostName\FolderName.

4.  Set options for the HTML version of the document by clicking the HTML Options button.  

5.  In the Actions tab, specify the actions you want Broadcast Agent to perform.

6. Click the Scheduling tab and specify the time or intervals at which you want Broadcast Agent to process the document.

7. Click OK.

Glossary

 XE "Glossary" 
2-D chart- Chart - that has a 2-dimensional look; displays the data for two variables, one on the X-axis and the other on the Y-axis.

2-D matrix chart- Chart that displays the data on three axes (X, Y and Z).

3-D chart- Chart type that has a 3-dimensional look.

3-D matrix chart- Chart that has a 3-D look, and that displays data on three axes (X, Y and Z).

Add-In- Program that adds optional commands and features to BOA.  Add-ins have the .rea extension to the file name.

Aggregate - Operation that makes a calculation on data, using a function such as "sum", "average", "maximum", etc.

Alerter - Report feature that applies specified formats or contents to cells.  The formats or contents are applied if the data in the cells falls within a given range of values, or satisfies conditions you set.

Area chart - Chart type that shows the relative importance of values over a period of time.

Ascending sort - Sort order that displays data text from A to Z, numbers from the smallest negative number to the largest positive number, and dates and times from the earliest to the latest.

Axis - Chart element that appears either horizontally at the bottom of the chart's wall, or vertically at the side of the chart's wall.  Used to trace the values of the data plotted in the chart.

Axis label - Chart element that appears next to or below an axis, that provides information on the data displayed on the axis.  

Block - The generic term used in BOA to describe tables, cross-tabs and charts.  

Block context - Subset of data from a microcube that can be displayed in one block in a report.

Body  

    1.  The area covered by the columns in a table, not including the column headers.

    2.  The area covered by the intersection of rows and columns in a cross-tab.

Break - Report feature that you apply on a dimension-type variable in a table or cross-tab.  Splits up the values by inserting a blank cell after each one.  Enables you to display calculations on the isolated values, e.g., percentage of revenue per customer.

Broadcast Agent - A BOA product that offers scheduled or batch processing of reports.  At specified times or intervals, Broadcast Agent can perform the following tasks: refresh and print reports, publish them on a web server, send them to other users and execute custom scripts.

Cartesian product - A result of a query in which two or more tables are not linked by a join.  For two unlinked tables with n and m rows respectively, the result will contain n m rows containing all the possible combinations of data from the two tables.

Cell - Report element that can be a header, a footer, a master cell, or a free-standing cell, and which also makes up the rows and columns of tables and cross-tabs.

Chart - Type of block in which data is represented graphically.

Class - A logical grouping of objects inside a universe.  Also know as a “Folder”.

Column - Vertical list of data in a report, part of a table or cross-tab.

Column chart - Chart type that shows data in columns.  Illustrates variation over a period of time, or comparison between values.

Combined query - Query consisting of two or more query definitions, each of which appears in a separate tab in the Query Panel.  The tabs are linked by an operator (UNION, INTERSECT, or MINUS) which specifies the query result.  UNION combines the results, INTERSECT returns data common to the results of each query, and MINUS excludes the result of one of the queries from the global result.  

Concatenation - Technique that enables you to link information (e.g., text) via an operator.

Condition - Way of forcing a query to retrieve data that meets a set of criteria.

Connection - Set of parameters that provide access to an RDBMS.  These parameters include system information such as the data account, user identification and the path to CSU Database.  In BOA, there are two types of connections: shared and personal.

Context - Query feature that enables you to select a path required to retrieve data, when there is more than one possible path.

Cross-tab - Block type that displays data in columns, rows and at the intersection of the columns and rows.

Data label - Chart element that appears in the chart itself, to show the values of data that is displayed.

Data marker - Chart element that shows the exact position of a value

Data provider - Mechanism that retrieves data for reports.  The following types of data providers are available: queries on universes, stored procedures, free-hand SQL scripts, personal data files and OLAP servers and Visual Basic for Applications procedures.

Data series - Chart element that displays values for variables, for example a line in a line chart.

Database administrator - Person who manages access rights to relational databases and who generally controls CSU Database setup at a site.  Also referred to as DBA.

DBA - See "database administrator".

DDE - See "Dynamic Data Exchange".  

Derived variable - Variable that you create in a report, whose values are derived from those of an existing dimension-type variable.  You select values returned by the existing variable and group them as new values of the derived variable.

Descending sort - Sort that displays text from Z to A, numbers from the largest positive number to the smallest negative number, and dates and times from the latest to the earliest.

Designer - See "universe designer".

Detail - Qualification for an object in a universe, a user object, local variable or a column of data, that provides supplementary information on a dimension.  Always associated to a dimension.

Dimension - Qualification for an object in a universe, a user object, a local variable or a column of numeric data; enables you to build hierarchies and therefore to perform analysis in drill mode.

Document - BOA file (extension .rep) that acts as container for reports.

Document exchange - BOA feature that enables you to send and receive reports to and from other users.

Drag-and-drop - Technique for moving cells and their contents.  Consists of selecting cells, positioning the mouse pointer on the selection, pressing and holding the mouse button, moving the mouse, and releasing the mouse button.  Thus the cell is "dropped" at a new location.

Drill by - In drill mode, task that displays data on the same level of detail but for a different dimension.  For example, you can drill across from revenue per year to revenue per country.

Drill down/drill up - Technique for analyzing data on different levels of detail.

Drill mode - Working mode that you use to analyze data on different levels of detail.  Enabled by the optional BOA Explorer component.

Drill through - Allows you to bring in more data from CSU Database directly into drill mode analysis.  

Drop lines - Chart element; a line that extends from a value in the chart to the X-axis.  Only available for 2-D line charts and scatter charts. 

Duplicate rows - Rows of data that appear more than once in the result of a query.

Dynamic Data Exchange - A Windows feature that enables you to export data from BOA to another application, such as Microsoft Excel.  The data in the target application can be automatically refreshed when the data in the host application changes.

Enterprise mode - A working environment in which you have access to a repository.  The mode in which a report is saved determines whether other users are able to access it.  By default, a report is saved in the mode in which you are working.

Environment variable - Variable used to customize BOA security.

EXPLORER - Module of BOA that enables drill mode.

External functions - Function developed in C++, using files delivered with BOA.

Filter - Report feature that enables you to display a limited set of data.

Folder - Windows 95 term, synonym for "directory".  Also “Class”

Formula - In a report, combination of functions, operators, variables and/or local variables, displayed in a cell that calculates a new value based on existing values.

Formula bar - Interface element that appears below the toolbars in BOA, where you can enter, view, modify and delete formulas that appear in cells in the report.

Free-hand SQL - Type of data provider that you define by writing your own SQL scripts, or by using existing SQL scripts.

Free-standing cell - Cell in a report that is not associated to any other report element.  For example, the cell that contains a report's title is a free-standing cell.  

Function - Predefined formula delivered with BOA that performs an operation on report values, then returns resulting values.  Can be used alone or in more complex formulas that you create.

Gridlines - Horizontal and vertical dotted lines that you can display in a report.  Gridlines make it easy to move and align blocks and cells inside the report.

Group of conditions - Two or more query conditions that are combined by the same operator (AND or OR).

Hierarchy - Feature of multidimensional analysis that ranks dimensions from "less detailed" to "more detailed"; enables analysis on different levels of detail in drill mode.

High-low lines - Chart element; a line going from the highest to the lowest value for numeric data.  Only available for 2-D line charts and scatter charts.

Incompatible object - In a universe, objects are incompatible if they belong to different contexts.  The universe designer creates contexts when a universe maps to a database containing two or more paths between tables.  Queries containing incompatible objects generate multiple SELECT statements and thereby retrieve multiple microcubes.  

INTERSECT - An SQL operator that combines two queries into a single query; specifies that the combined query only return only the data that is retrieved by both the first and the second query.

Legend - Chart element containing text and symbols that show the formats of the data series in the chart.

Legend key - Chart element (inside the chart legend) that presents the patterns, colors and borders of the data series in the chart.

Line chart - Chart type that plots data in lines.  Emphasizes trends in data over time.

List of values - Values, returned by a query, that you can select when defining simple query conditions, or conditions that include either the "Equal to" operator or the "In list" operator.  Typically contains the values returned by a query containing one object.  

Local variable - Formula that is given a name and which is included in the list of variables that are available in a report.  A local variable is only available in the report in which it was created.

Loop - In a relational schema, situation in which different paths can be used to link two database tables.

Macro - A series of commands and functions that are stored in a Visual Basic module and can be run whenever you need to perform the task.  Macros are used to automate tasks that you need to perform frequently

Master - Variable in a master/detail report that appears in the master cell of the report's sections.  The rest of the data in each section corresponds to the master.

Master cell - In master/detail reports, the cell inside a section to which the other data in the section corresponds.

Master/detail - Type of report that displays data in sections.  In each section, an individual cell displays one value returned by a master variable, plus one or more corresponding blocks of data.

Master / master / detail report - Report structure that displays data in sections, which contain two master cells and one or more corresponding blocks of data.

Master / multi-detail report - Report structure that displays data in sections, which contain at least one master cell and two or more corresponding blocks of data.

Matrix - See "cross-tab".

Matrix chart - 2-D or 3-D chart that displays data on three axes (X, Y and Z).

Measure - Qualification for an object in a universe, a user object, a local variable or a column of data; measures return numeric data that is the result of a calculation including an aggregate function.  

Microcube - Structure in which the data retrieved by a data provider is stored in a report on the client computer; houses the data that you can display in the report(s) inside the report.  Most data providers return a single microcube.  However, queries containing incompatible objects return two or more microcubes.  Such queries generate multiple SELECT statements.

MINUS - An SQL operator that combines two queries into a single query; specifies that the combined query return the result of the first query less the result of the second query.

Multidimensional analysis - A technique for looking at data from different viewpoints and on different levels of detail.  Multidimensional analysis involves drill and slice and dice.

Object - Universe element that represents a set of data from a relational database in terms that pertain to Army.  Included in a query to retrieve data from CSU Database.

Object Linking and Embedding version 2 - A Windows feature that enables you to use data, text and pictures in different applications.  OLE 2 objects are created from files (text, ASCII, spreadsheet, bitmap) and are linked or embedded inside files in other applications.  For example, OLE 2 enables you to embed a bitmap image in a BOA report.

Offline mode - A mode that disconnects you from the repository, and which disables commands or options that require a connection.  

OLAP server - Type of BOA data provider that retrieves data from a multidimensional or relational Online Analytical Processing (OLAP) database.

OLE 2 - See "Object Linking and Embedding version 2".  

Operand - Query condition element that is compared to the object in the condition.

Operator 

    1.  Query condition element that specifies the relationship between object and operand.

    2.  Element that specifies the relationship between other elements of a formula in a report ("equal to", for example).  

Page background - Picture that is displayed in the background of every page of a report.

Page footer - Cell that appears at the bottom of every page of a report.

Page header - Cell that appears at the top of every page of a report.

Personal connection - A type of connection that is specific to one user and stored on the user's computer.  Personal connections are static, i.e., they cannot be modified and are specific to the report the user is working on.

Personal data file - Type of data provider that enables you to retrieve data from files (spreadsheet, dBASE etc.) that contain personal, as opposed to corporate, data.

Pie chart - Chart type that displays data as slices of a circular pie.  Shows the relationships of parts to a whole.

Pivoting - Technique that enables you to switch the position of data in a report, to view the data from different standpoints.

PL/SQL - Programming Language/SQL.  Extension of SQL developed by ORACLE.  In BOA, PL/SQL is used in free-hand SQL.

Plot area - Chart element that covers all the data plotted in the chart, the chart's axes and their labels.

Predefined condition - A condition defined by the designer in DESIGNER that you apply on queries in the Query Panel.

Prompt - Sentence or question in a query condition that incites you to select or enter values for the condition.

Purge - Action that deletes the data returned by a list of values, or by a query or other type of data provider, but does not delete the definition of the list of values or query.

Qualification - Status of an object, a user object, a local variable or a column of data (dimension, measure).

Query - Type of data provider, built in the Query Panel and run on a universe.  

Query file - A file with the .bqy file extension; corresponds to a query definition and stores the data retrieved by a query.

Query Panel - Interface in BOA that you use to build, edit and run queries.

Query result - The data returned by a query, also referred to as a report's microcube.

Ranking - Report feature that enables you to display only the top and bottom values returned by a variable.

RDBMS - Relational Database Management System, enables the creation, management and deployment of relational databases.

Refresh - Updates data from an external data source.  Each time you refresh data, you see the most recent version of the information in CSU Database, including any changes that were made to the data.

Report - Focal point of your work with BOA, where you view, analyze and format data.  The data in reports can come from one or many sources.  You can also display text and graphics in reports.  Reports are located inside reports.

Report Manager - Report Manager is a key part of the BOA workspace that enables you to manage different aspects of your work quickly and easily.  From one window, you can manage all the variables in your report, work on the structure and formatting of report components and use navigation view to go quickly from section to section or report to report.

ReportScript - Programming language used in BOA 4.x to create scripts.  These scripts can be automatically converted into the VBA macros used in BOA 5.x.

Repository - Centralized storage and distribution mechanism that manages universes, user information and report exchange.

Result object - Object that is included in a query

Row - Part of a cross-tab that displays data horizontally.

Scale - Chart element that shows the values of data on an axis, the intervals between these values and the point where values coincide between two axes.

Scatter chart - Chart type that shows the relationship between numeric values in several data series, or that plots groups of numbers as one set of x-y coordinates.

Scope of analysis - Subset of data returned by a query or other type of data provider, used to perform analysis on the data displayed in a report.

Script - Series of commands written in ReportScript and stored in a file and used to automate tasks in BOA 4.x.  These scripts can be automatically converted into the VBA macros used by BOA 5.x.

Section - Part of a master/detail report.  A section contains a master cell in which a single value of a variable is displayed and one or more blocks in which variables corresponding to the master cell value are displayed.  A section is created for each value returned by the variable in the master cell.

Security domain - If the supervisor has set up multiple repositories, when you log on to BOA, you have a choice of security domains to log on to.  If you are unsure which domain to select, contact your BOA supervisor.

Shared connection - A type of connection that is specific to one user and stored on the user's computer.  Personal connections are static, i.e., they cannot be modified and are specific to the report the user is working on.

Simple condition - Query condition that you apply on a result object, then by selecting values from the object's list of values.

Slice and dice mode - Working mode that you use to restructure a report to analyze its data from different viewpoints.  The Slice and Dice Panel is the interface in which you work in slice-and-dice mode.  

Slice and dice panel - Interface that provides a representation of the data in a report; enables you to restructure the report and thus to analyze its data.  Only available with the Analyzer component.  

Sort - Feature that you can apply on objects in queries and on data in reports; forces data to appear in ascending or descending order.

Sort priority - Ranking of sorts in a query or in a report.

SQL - Structured Query Language, the language used to interact with relational databases, used in BOA.

SQL statement - Command that carries out an action in SQL.

Stacked chart - Chart type that shows data series as parts of a whole.

Stored procedure - Combination of SQL statements that are translated, optimized and stored in executable form on certain SQL servers.  Type of data provider in BOA.

Structured Query Language - The language used to interact with relational databases, used in BOA. (SQL).

Subclass - Class in a universe that appears inside another class.

Subquery - Query that is nested in a main query, required by a condition that includes the "Create a subquery" operand.  The result of the subquery is compared with that of the main query.  

Supervisor - User of SUPERVISOR and responsible for user administration information such as user names and passwords.  The supervisor creates user rights and profiles.  The person who manages BOA system resources, such as the repository, is referred to as "general supervisor".  

Table - Block type that displays data in columns or in rows. 

Template - Report that provides report layout and formats that you can apply to existing reports and that you can use when creating new reports.

Transact SQL - SQL dialect developed by SYBASE.  With BOA, Transact SQL is used in free-hand SQL.

Transparent sort - Sort on an object that is not included in the query result.  

UNION - An SQL operator that combines two queries into a single query; returns the result of both queries as a single result.

Unique universe name - Usually the universe name (the long name).  If there is no long name, the short name (the filename with .unv extension) is used.  If there are several universes with the same name in a list, then the following is added to distinguish them: - for a local universe, the filename between ( ) - for an exported universe, the domain name between [ ].

Universe XE "Universe"  - Semantic layer between you and a database, consisting of classes and objects.  The objects in the universe map to data in CSU Database, and enable you to build queries on the universe when creating or working on reports.

Universe designer - A user of DESIGNER.  Creates and maintains universes for a particular group of users.  The universe designer distributes universes to users by exporting them to the repository or by moving them as files through the file system.

Universe domain - The area of the repository that holds exported universes.  The universe domain makes it possible to store, distribute, and administrate universes.  There may be multiple universe domains in a repository

Up-down bar - Chart element that extends from the minimum to the maximum value in the first two data series in a group.  Up-down bars are useful for comparing relationships between two data series and are only available for line charts and scatter charts

User object - A type of object in a BOA universe.  Created in BOA, by an end user, to meet specific needs, e.g., to concatenate two existing objects from the universe.

Value-based break - Break that you apply on some rather than all the values of a variable.

Variable - Report element that presents a named category of data.  Corresponds to columns of data returned by queries or other data providers.

Wall / floor - Chart element that forms a rectangle, bound by the chart's axes.  3-D charts can also have a side wall and a floor.  

WebIntelligence file - WebIntelligence is a BOA product that allows you to use a web browser to create reports based on BOA universes.  A WebIntelligence file contains a query, the data returned by the query, a report format, and a header showing who sent and saved the query, and the size of the file.  A WebIntelligence file has the extension .wqy.

Workgroup mode - A working environment in which you do not have access to a repository.  The mode in which a report is saved determines whether other users are able to access it.  By default, a report is saved in the mode in which you are working.

WYS/WYG - "What You See Is What You Get", means that what you see on the screen is what you will get when you print the report.

X-axis - Chart element that extends from left to right horizontally along the base of the chart, along which data is plotted.

XY chart - See "scatter chart".

Y-axis - Chart element that extends vertically on the left of the chart where numeric data is plotted.

Z-axis - Optional chart element for matrix charts only, along which data is plotted.  Extends vertically and to the right from the right end of the X-axis.
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12

Resize the title cell height manually
12

Resizing Columns and Rows
12

Retrieving reports that users have sent
52

Saving a document
11

Saving a report using a different name
11

Saving Documents in HTML Format
56

Saving HTML Documents
54

Scheduling BOA documents
53

Sections
38

Set up your own toolbar:
8

Settings tabs
30

Sharing information
52

Showing headers and footers
32

Slice-and-Dice
46

Sorting Data
16

Special characters in HTML
57

Standard report
28

Structure
43

Structure an existing report
47

Styles
29

Swap two variables
24

Switching to drill mode
20

Table Block
10

Template
28, 43

Templates and Standard Report Styles
28, 43

To save a BOA Document as HTML
54

Turn a chart to a table or a cross-tab in slice-and-dice mode
50

Turn a table or a cross-tab to a chart in slice-and-dice mode
50

Undoing drill actions
22

Universe
19, 70

Using Templates
40

Using the Drill toolbar
24

Viewing Documents
10

Web Publishing
53

Web publishing process
55

Web Publishing with Broadcast Agent
58

Work with master/detail reports
46

World Wide Web
54
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